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Enterprise Receive Extension
(SMSRX) Setup Guide
for use with SMS-3000

Retain for future use.

HAZARD CATEGORIES AND
SPECIAL SYMBOLS

Read these instructions carefully and look at the equipment to become
familiar with the device before trying to install, operate, service or maintain
it. The following special messages may appear throughout this bulletin or on
the equipment to warn of potential hazards or to call attention to information
that clarifies or simplifies a procedure.
The addition of either symbol to a “Danger” or “Warning” safety label
indicates that an electrical hazard exists which will result in personal injury if
the instructions are not followed.
This is the safety alert symbol. It is used to alert you to potential personal
injury hazards. Obey all safety messages that follow this symbol to avoid
possible injury or death.

DANGER
DANGER indicates an imminently hazardous situation which, if not
avoided, will result in death or serious injury.

WARNING
WARNING indicates a potentially hazardous situation which, if not
avoided, can result in death or serious injury.

CAUTION
CAUTION indicates a potentially hazardous situation which, if not
avoided, can result in minor or moderate injury.

CAUTION
CAUTION, used without the safety alert symbol, indicates a potentially
hazardous situation which, if not avoided, can result in property damage.

Provides additional information to clarify or simplify a procedure.

PLEASE NOTE

Electrical equipment should be installed, operated, serviced, and
maintained only by qualified personnel. No responsibility is assumed by
Schneider Electric for any consequences arising out of the use of this
material.
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INTRODUCTION
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Introduction

The Enterprise Receive Extension (SMSRX) is one of the software
components of an enterprise-wide POWERLOGIC® Power Monitoring and
Control System. Three key software components make up the system:

•

Push application. The Push application is an add-on to the
POWERLOGIC system software on POWERLOGIC Power Servers.
When activated, the Push application collects, packages, and sends the
data from remote devices via file transfer protocol (FTP) to a central
receiving SMS server.

•

SMSRX application. SMSRX is an add-on to SMS-3000 and is installed
on the receiving server. SMSRX receives data from remote devices and
prepares it for the central database. The receiving server can accept
pushed data through SMS or other custom applications.

•

SMS-3000 software. When SMS is used in combination with Push on
the remote site and SMSRX on the receiving server, SMS can accept
remote data into its system and history database. Once received, the
data is available for viewing and analysis in SMS.

Figure 1:

Components of the POWERLOGIC Power Monitoring and
Control System

SMS-3000
with SMSRX

Central Receiving Server

Remote Power Server
with Push

Remote Power Server
with Push

This powerful system lets you communicate with devices that are not directly
connected to your server. The system can be as simple as one device
communicating through a Power Server across an Intranet to a receiving
server, or as complex as a system with multiple devices and multiple Power
Servers that push data across the Internet to multiple locations.
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INSTALLATION
System Requirements

Software:
Make sure your system meets the following requirements:

•
•

Enterprise Receive Extension (SMSRX) version 3.3.2.
Power Server 710 or 750 version 4.0 or higher with Push version 1.01
enabled. You should have created a system and added the devices to
the Power Server.
If you have a Power Server 710 or 750 version 3.0 with Push version
1.01, the file version must be is 3.3.12.0 or higher. To check the file
version, locate the Push.exe on the Power Server, right click the name,
and view the properties for the file version information. See the Power
Server documentation for more about exploring files on the Power Server.

•

SMS-3000 version 3.3.2 installed on a single server with Microsoft
Windows® 2000 Server or Advanced Server operating system. The
server must have a static IP address. Split-server configuration where
SMSRX is installed on more than one server, requires custom
engineering services.

•

The server should be dedicated to your POWERLOGIC® System. No
other software should be installed.

Hardware:
The following are recommended specifications for an SMS-3000 server PC
running the SMSRX extension. Systems meeting these specifications will
provide the performance necessary to process the data volumes of typical
enterprise-wide power monitoring system. We recommend that you
purchase the fastest processor available at the time of purchase.

•
•
•
•
•
Procedure Summary

1.26GHz Pentium III
1024MB SDRAM
100G 10K RPM hard drive
Windows 2000 server with 5-client operating system
Disk drive, CDRW, and 56K internal modem

Before you begin installation and setup, you should set up a Windows
account name and password for the server.
When setting up the Windows account, make sure to:
•

Create an account name that is different from the computer name.

•

Set the account rights to the Administrator or Power User level.

•

Set the password to “Never Expire.”

The required steps for configuring the receiving server are summarized
below. Follow the installation procedures in the order they are presented:
1. Configure Internet Information Services (IIS) to receive FTP files.
2. Install SMS-3000 version 3.3.2.
3. Install SMSRX.
4. Activate and configure Push on the Power Server.
5. Add a corresponding device in SMS for each remote device.

4
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6. Use the Mapping Utility (an SMS tool installed with SMSRX) to map each
corresponding SMS device to its remote device.
7. Create local tasks in SMS for the remote devices and map those remote
functions to local tasks (optional).
These procedures are detailed in the sections that follow.

Configuring IIS on the Receiving Server

Internet Information Services (IIS) is a component of Windows and must be
installed and configured. To verify if all components of IIS are installed:
1. Click Start > Control Panel > Add/Remove Programs > Add/Remove
Windows Components and click IIS.

2. Click Details and check that the ISS components are installed.
These boxes must be checked:
— Internet Information Services Snap-In
— File Transfer Protocol (FTP) Server

If IIS (or one if it’s components is not installed), install it.

© 2003 Schneider Electric All Rights Reserved
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Once installed, configure IIS to receive files via FTP. Follow these setup
steps:
1. Launch IIS (Start > Programs > Administrative Tools > Internet Services
Manager).
The IIS Tree directory displays.

2. Right-click Default FTP Site and select Properties.
The FTP Site tab displays.

3. Make sure the Enable Logging box is checked on the FTP Site tab.

6
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4. Click the Home Directory tab.

5. Check the Write box and click Apply.
6. Click the Security Accounts tab.

7. Uncheck the Allow Anonymous Connections. Do not allow anonymous
connections and click Apply.
8. Click OK and close IIS.
Your server is now ready to receive files via FTP.

© 2003 Schneider Electric All Rights Reserved
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SMS-3000 version 3.3.2 is required for use with SMSRX. Install SMS-3000
according to the installation instructions included with your SMS software.
Be sure to restart the server after installation is complete.
NOTE: If SMS-3000 has been running and data has been collected in the
system database, use Database Services to make a backup of the system
setup database. For instructions, see “Backing Up the SMS Databases” in
the SMS online help file.

Installing SMSRX

Before you begin:
1. Make sure you have logged on to the receiving server with the same
Windows account that you are now going to set up to run SMS as a
service.
2. On the Push FTP Site directory on the Power Server, make sure you
have configured Push to use the Windows account and password of the
receiving server and that the FTP directory is SMSRX.
3. If SMS is running, shut down the SMS client and server.
To install the SMSRX software on the receiving server (where the data will
be received), follow these instructions:
1. Insert the installation CD into the CD-ROM drive.
2. If you have not disabled the autorun feature, the Autorun screen
displays.
3. Click Install.
If the Autorun screen does not display, click Start > Run ... to open the
Run dialog box. Click Browse ... and scroll to the CD drive. Highlight
Setup.exe and click OK.
This warning dialog displays.

If any anonymous IIS accounts are set up on this server, exit the install
procedure and disable these accounts. See “Configuring IIS on the
Receiving Server” on page 5. When the anonymous accounts are
disabled, continue with the install.

8
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4. Click OK to bypass the Warning.
The Backup Recommendation dialog displays.

If SMS has been running and you have added system information
(devices, user accounts, etc.), you must back up the system database. If
you did not do this before you began the SMSRX installation, quit the
installation, launch SMS, and use the Database Services feature to back
up the database.
5. Click Yes if no data has been collected in the system database, or if you
have made a backup copy of it.
The Enterprise Receive Extension (SMSRX) welcome screen displays.
6. Click Next to begin the installation.
The License Agreement screen displays.
7. Click Yes to accept the licence agreement.
The About the SMS Account Selection screen displays.

You should run SMS as a service.

© 2003 Schneider Electric All Rights Reserved
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8. Click Next.
The Run Mode dialog displays.

9. On the Run Mode dialog:
a. Leave the box unchecked (to run SMS as a Windows service).
b. Click the account name to select the Windows account name that will
run SMS as service.
c. Enter the password for the account.
d. Re-enter the password in the Verify field.
10. Click Next.
The Start Copying Files dialog displays.
11. Click Next to proceed with the installation.
Installing the files could take several minutes. When setup is complete,
the Registration Form dialog displays.
12. Click Close to bypass the registration or register your SMSRX software.
13. Click Finish to restart the server.

10
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The server reboots. The services will restart SMS. The SMSRX install
program does the following:

Setting Up the Push Application

© 2003 Schneider Electric All Rights Reserved

•

creates a new default FTP site called “SMSRX” (which matches the Push
FTP site configuration) and defines a virtual directory called
“SmsReceive.” The new subdirectory (SmsReceive) is located under the
SMS-3000 main directory on your receiving server. All incoming files via
FTP will be moved from default FTP site (SMSRX) to the SmsReceive
folder. The SMSRX application watches this directory for any pushed
files.

•

adds two utilities (Parser service and File Forwarder) that manage the
services for SMSRX. The services package and place the files in the
appropriate directories. See “Appendix A— How Files are Managed” on
page 21 for more about remote files.

•

installs the Mapping Utility, which is described in “Mapping Devices to
SMS” on page 14.

•

adds an entry (Enterprise Data Extension) to the Start > Programs >
SMS-3000 menu.

Your remote system should be set up; that is, you should have created a
system and added devices to your POWERLOGIC system on the Power
Server. You must also activate and configure the Push application according
to the instructions in the Push Setup Guide. After completing the installation
and setup of the Push application, Push begins to collect and package the
data, sending it to the default FTP site on the receiving server.

11

Enterprise Receive Extension (SMSRX) Setup Guide
Installation

63220-074-200A1
1/2003

When configuring the FTP Site in Push, the FTP site directory must be
named SMSRX. The user name and password defined on the FTP Site tab
in Push must match the Windows account user name and password on the
receiving server. Restart the Push application to immediately send a file to
the receiving server.

Also, if you are using version 3.0 of the Power Server, you must upgrade to
the latest version of the Push. See “System Requirements” on page 4.

Adding Corresponding Devices to SMS

Even though you have devices added to the Power Server, you must also
add a corresponding device in SMS for each remote device.
This is true for most cases except when you are communicating in real-time
directly to devices and also pushing data from those same devices to your
receiving site. In this case, if you already added the devices in SMS, skip to
“Mapping Devices to SMS” on page 14. You do not need to add the device
again.

Before adding devices to SMS:
1. Launch the SMS client, click Start > Programs > SMS-3000 > SMS-3000
Client.
2. Add a communication connection for the remote Power Server, using the
same IP address of the Power Server.
3. Launch the Mapping Utility; from the SMS toolbar, click Tools > Mapping
Utility.
4. Log in to the Mapping Utility using an SMS user ID and password. The
user ID must have an access level from 1 to 5.

To add a remote device to SMS:
1. In SMS, go online with your system (File > Online > System).
2. Click Setup > Devices/Routing to display the Setup Devices dialog box.
3. Click Add to display the Add Device dialog box.

4. Enter the Device Name.
We recommend that you use the same device name or a name that
helps you relate the corresponding device to the remote device on the
Power Server.
You can copy the device name that you used in your remote system. Go
back to the Mapping Utility and click Display Remote Device.

12

© 2003 Schneider Electric All Rights Reserved

63220-074-200A1
1/2003

Enterprise Receive Extension (SMSRX) Setup Guide
Installation

The remote device list displays.

5. Right click the device and copy the name.
6. Return to the Add Device dialog in SMS and paste the name into the
Device Name box.

7. Complete the entries for the Add Device dialog:
Device Type: Select the type of device you are adding.
Connection Name: Select the Power Server communication connection
that you defined.
Remote Device box: Check the box.
8. Click OK to save the device information.
SMS displays the routing dialog for the Connection Name you chose. We
recommend that the device address on the Power Server is the same
device address in the SMS system. For example, if you add a CM4000
with address 3 to the Power Server system, use address 3 for the device
address of your corresponding device in SMS.
9. Click OK to save the routing information.
10. Repeat these steps until all the remote devices are added to SMS.
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After you have created the remote device on the Power Server and added its
corresponding device to the SMS system on the receiving server, you must
map the two devices using the Mapping Utility. The Mapping Utility is
installed as a tool in SMS when you install SMSRX.
You can also use the Mapping Utility to associate remote alarms with local
SMS tasks, and you can view the types of information being sent from Push.
Each screen of the Mapping Utility has a Help button that explains how to
use that particular screen.
Follow these instructions to map devices:
1. If SMS is not already running, launch it and put the system online
(optional).
2. If the Mapping Utility is not launched, start it from the SMS toolbar (Tools
> Mapping Utility).
A login screen displays.
3. Log in to the Mapping Utility using an SMS user ID and password. The
user must have a level 5 access or better (levels 1 through 5).
The Mapping Utility screen displays.

4. Highlight the device that you want to map and click Add Mapping.
The Add Mapping screen displays.

5. Highlight the corresponding remote device on the Power Server and
click OK.
Repeat steps 3 and 4 until you map all the remote devices.
6. After mapping all of the devices, exit the Mapping Utility and return to
SMS.
14
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After installation and setup of SMSRX is complete, Push sends the remote
data to the receiving server where the data is added to the SMS database.
This data includes:

•
•
•
•
Data Types from Push

Historical data
Waveforms
Alarms
Events

Historical data from remote devices is viewable in Information Manager.
You can view both PC-based and on-board (device) logged data, including
100 ms data logs from CM4000 circuit monitors.
Remote device data may be reported with N/A in Information Manager
reports because data may be being pushed for one device, but not another
at every interval. For example, if one device logs every minute and another
device logs every 10 minutes, then the second device will often show N/A
because no data was logged at the time Push sent the file.

Remote waveforms files are pushed to the receiving SMS server, marked
as remote (remote <mapped device name> date/time stamp.) Remote
waveforms include disturbance, adaptive, transient, and steady-state
waveforms—including those that are manually triggered.
Remote active alarms are annunciated in the Active Alarms window in SMS
and marked as remote by an (R) next to the alarm name. Remote alarms are
handled like any other alarms and can be viewed in the Alarm Log, except
that remote alarms can only be acknowledged as a group, using the
Acknowledge All Alarms button. Also, remote functions are not shown in the
Active Functions window (the dialog you view when you click the Functions
button
on the SMS toolbar).
Because remote alarms are handled like onboard alarms, the alarm will
remain in the Active Alarm view for one alarm scan. Increase the Onboard
Alarm Check cycle in SMS to improve the chance that remote alarms will
stay in the Active Alarms window longer. See “Intervals Tab” in the SMS
online help file for more information.

See “SMS System Monitoring” on page 16 for information about special
alarms installed for SMSRX.
Events from Power Servers provide useful information on the status of
remote systems and devices. These events are time stamped and viewable
in the SMS activity log:

•

Remote system events:
— System online or offline
— Server started or stopped
— Remote site out of service. When no files are received from a site, a
“remote site out of service” message is placed in the Activity Log and
an alarm is generated in the Active Alarm window.
— Remote site back in service. When a file is received after a site has
been out of service, a new event “remote site back in service” is
generated and the alarm is removed from the Active Alarm window.

© 2003 Schneider Electric All Rights Reserved
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•

Remote device events:
— Device deleted or added
— Device comms loss*
— Device comms restored
— Device in sync with the database
— Device out of sync with database*
— Device name changed
*Also annunciated as alarms

For more about data management, see “Appendix A— How Files are
Managed” on page 21.

Tasks

You can create local tasks on the receiving server in SMS to respond to
remote alarms. For example, you can setup an email task to notify personnel
of an alarm condition on the remote device. Because SMS is running as a
service, you can launch executable files (.exe files) with a task, but the
executable must be able to run and shut down without user interaction.
You must first set up the task in SMS and associate the task with the remote
device. Then, map the task to the alarm, using the Mapping Utility. See the
Mapping Utility online help file for instructions.

Date and Time Synchronization

Date/time stamps on data received from other time zones are automatically
converted to the time of local receiving server. This makes it easier to
analyze data from across time zones at a central location.
For example, if the receiving SMS server is located in one time zone, and a
waveform was captured by a remote device in another time zone, then the
time stamp on the waveform would be adjusted to time zone of the receiving
server. The time stamp is also adjusted if the receiving server is set for
daylight savings.

SMS System Monitoring

Two specials events (and their associated alarms) have been created for
SMSRX. The remote site out of service and remote site back in service let
you know if your remote site is down.
Another feature of SMSRX is its ability to monitor some file management
activities of the SMS system, and to annunciate alarms for those activities.
The system monitors these activities:

•
•
•

the size of the SMS database
hard drive usage of the receiving server
presence of files coming from Push

When SMSRX is installed, a “Monitoring App” device is automatically added
to your SMS system and is displayed in the device list in the Mapping Utility.
You do not need to map this “device.”

16
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This screen capture shows the Monitoring App device.

Also installed are the preconfigured alarms associated with it. In SMS, click
Setup > Functions/Alarms to display the Assign Functions tab.

Click the Monitoring App device to display the functions:

•
•
•

DB Size Monitor (database size)
HDD Monitor (hard disk size)
Log Monitor (Push logged files)

To view the setpoints for these functions, in the Functions Selected box,
click the function, then click Setpoints.

© 2003 Schneider Electric All Rights Reserved
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Database Size Monitor

The DB Size Monitor is a function that monitors the size of your SMS history
database (sms_history_data.mdf). The alarm conditions Highest and High
are preconfigured to alarm when the database reaches it 80% and 70%
levels. The pickup and dropout setpoints are based on MB used and are
calculated for your server when SMSRX is installed. When you receive an
alarm for database usage, you should archive the SMS database. See the
SMS online help file for instructions on archiving.

Hard Drive Usage Monitor

The HDD Monitor is a function that monitors the percent of used space on
the server’s hard disk. The alarm conditions Highest and High are
preconfigured to alarm when the hard disk reaches it 90% and 80% levels.

18
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When you receive an alarm for the drive usage, look at how much space is
being used to store these following files:

Log File Monitor

© 2003 Schneider Electric All Rights Reserved

•

Waveform captures. Stored in the SMS-3000\Export\Comtrade folder,
you can copy the files off the server and delete them from this folder.

•

Historical files. Make sure you are using the archiving feature of SMS to
archive the SMS_History database. See the “Backing Up and Archiving”
in the SMS online help file.

•

Temporary log files. Temporary SMS log files are stored in the
csinfo.db.log and csinfo.log and indicate that data is not being added to
the database successfully. If these log files are growing extremely large,
you may have a problem in your system. Copy the file off the server and
contact technical support for assistance.

•

Temporary Windows files. Consider deleting files from the
C:\WINNT\Temp folder.

The Log Monitor is a function that will annunciate an alarm when the
receiving SMS server has not received historical pushed data from a remote
site. For example, you will receive this alarm if data is not logged for two
hours. The alarm conditions Highest and High are configured to alarm when
the logging interval reaches 90% and 80% levels.
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Table 1:

Troubleshooting

Problem

Possible Solution
Restart Push to immediately send a file from Push.

No devices in the
Mapping Utility.

Click the Refresh List to receive any data from Push. See
“Mapping Devices to SMS” on page 14.
Make sure the corresponding device is added to SMS on the
receiving server. See “Mapping Devices to SMS” on page 14.
•

Check your FTP site configuration in Push. Make sure
the user account and password defined for Push
matches that on the receiving server. Make sure the FTP
site directory is SMSRX. Refer to the Push
documentation.

•

Check your IIS FTP site configuration on the receiving
server. See “Configuring IIS on the Receiving Server” on
page 5.

•

Click source details in the Mapping Utility and check
which data types are being sent from Push. See
“Mapping Devices to SMS” on page 14 and refer to the
Mapping Utility help file.

•

Check that each device added to the Power Server is
also added to the receiving SMS system and mapped in
the Mapping Utility. See “Adding Corresponding Devices
to SMS” on page 12 and “Mapping Devices to SMS” on
page 14.

•

Check the event log in the File Forwarder and File Parser
services. See “About the File Forwarder and File Parser
Managers” on page 22 for more about these services.

•

Check the Windows Event View on the Power Server to
see if any errors are logged from the Push application.

•

Check the File Parser and File Forwarder managers to
see if the services are running (status is indicated by a
green light). See “About the File Forwarder and File
Parser Managers” on page 22. Start the services if they
are not running or call Technical Support if you cannot
start the services.

•

Check the Event Log in the File Parser to see if any files
have been processed or any errors have been logged. If
services are running and you are not getting files, check
the Power Server setup and version.

•

If you have set up a Windows user account with a
password that expires, or the user account has been
removed, you may need to check or add the account
again. Use the SMS configuration Utility to do this (Start
> Programs > SMS-3000 > SMS-3000 Configuration
Utility). See the SMS help file for SMS Configuration
Utility information.

No data or data is not
what is expected.

Monitoring App
alarms

20

If you are receiving monitoring app alarms, see “SMS System
Monitoring” on page 16 for actions you can take to respond to
these alarms.

© 2003 Schneider Electric All Rights Reserved

63220-074-200A1
1/2003

APPENDIX A— HOW FILES ARE
MANAGED

Enterprise Receive Extension (SMSRX) Setup Guide
Appendix A— How Files are Managed

When remote files are sent to the receiving server via FTP, the files are
placed into the SMSRX virtual directory (C:\SmsReceive\Receiver). Two
services installed by SMSRX process the files and prepare them for use
with SMS.
The File Forwarding service takes all files from the SMSRX virtual directory
and moves them to the appropriate receive folder based on the file extension
name. Table 2 lists the types of data that can be sent from Push to the
receiving server and shows where the files will be placed.

Table 2:

Data Types sent from Push

Data Type

Description

File
Extension

SMSRX
Folder
Location
Alarm

Alarms

Remote alarm configuration, and alarms when they are annunciated on the remote system

.alrf

Events

SMS remote events, such as going online and offline

.evtf

Alarm

Log Data

Historical data, logged for reporting in Information Manager

.logf

History

Remote waveforms, sent one waveform per file.
Waveforms

.wfcf includes waveform setup data

.wfcf
.wfdf

.wfdf includes the points on the graph
.wfif for transients only, indicates the location of the transient

Waveform

.wfif

Devices

Remote device setup data

.cfgf

Setup

Systems

SMS system(s) from which data is being pushed

.cfgf

Setup

Diagnostics

PC events, from Push or SQL, that are captured in the Windows event viewer

.diag

unsupported

Watchdog

Periodic poll sent out by Push to verify that SMSRX is still communicating

.dawg

Setup

Configuration

FTP sites file contains configuration infomation about each FTP site defined in Push

.ftps

Setup

Once the data is received, the File Parser service parses the files. The File
Parser also places diagnostic files (.diag) pushed from the remote server to
the “unsupported directory.” The file manager periodically deletes old files
from this folder. Diagnostic files from the remote server are not put into the
database and are not sent to SMS.

© 2003 Schneider Electric All Rights Reserved

21

Enterprise Receive Extension (SMSRX) Setup Guide
Appendix A— How Files are Managed

About the File Forwarder and File Parser
Managers

63220-074-200A1
1/2003

Normally, the File Forwarder and File Parser services run in background and
the preconfigured settings do not need to be changed. However, to provide
flexibility in the software, the File Forwarder and Parser Service applications
can be launched from the Start Menu (Start > Programs > SMS-3000 >
Enterprise Receive Extension), and it is possible to adjust settings.
We have provided documentation about the File Forwarder Manager and
File Parser Manager in case adjustments need to be made to the system.

CAUTION
POSSIBLE CONFIGURATION PROBLEMS
We recommend that you do not change any settings in the File
Forwarder or File Parser applications. Only qualified POWERLOGIC
personnel should change these settings.
Failure to follow this instruction can result in software or equipment
malfunction.

File Forwarder

When the File Forwarder application is launched, the File Forward
Enterprise Service Manager displays.
Select whether service runs
automatically, manually, or
disable service.

Set which file extensions will
be processed and their
destination folder.

View events related to the
the processing of pushed
data by the File Forwarder.

Click Stop to stop the File Forward service. This also activates the
Advanced and Services Settings button. Click Start/Continue when you
want to restart the service. Notice that the Service Status displays green
when the File Forward service is running, and changes to red when the
service is stopped.
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Click Advanced to display the service type options.

Click Services Settings to display the File Forward Settings tab.

Saves event and error
messages to one file.
Leave unchecked.
Another service deletes
unsupported files.
File extensions processed
in by the forwarder service.

Folder destinations for
pushed files processed
by the forwarder service.

How often the forwarder
scans for pushed files in
the Source Path folder.

Click the Event Log tab to display it. Any events or error messages for
SMSRX are displayed on this tab.
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When the File Parser application is launched, the File Forwarder Enterprise
Service Manager displays. Stop the PLPRFileManager service first. Then,
stop the other services to activate the Service Settings or Advance button.
To restart all the services, restart the PLPRFileManager. This service will
restart all the others.

Click Services Settings to display the File Parsing Services tab. Each
service has a unique tab associated with it.
Setup File service tab

Selects the service setup you want to view.

Directories where the File Parser
processes the setup files.

Scans for setup files every 5 seconds.
Scans the not parsed folder every
60 seconds for unprocessed files.

History Manager service tab

Selects the service setup you want to view.

Directories where the
File Parser processes
the history files.

Scans every 6 seconds for
history files coming from Push.
Scans every 61 seconds
for unparsed files.
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Alarm File Manager service tab

Selects the service setup you want to view.

Directories where the File Parser
processes the alarm files.

Scans every 7 seconds for alarm files
coming from Push.
After the alarm is parsed, it sends the alarms every
62 seconds to the SMS Alarm Log and the Active
Alarm view if it applies (less than 24 hrs old).
Alarms less than 24 hours old are placed in
the SMS Active Alarm view, alarms older than
24 hours are placed in the SMS Alarm Log.

Waveform File service

Selects the service setup you want to view.

Directories where the File Parser
processes the waveform files.

Scans every 8 seconds for waveform
files coming from Push.
Scans the not parsed folder every
63 seconds for unprocessed files.

File Manager service tab

Selects the service setup you want to view.
Scans every 2 hours for files
coming from Push.

Keeps Push files in each directory
for 1 day before deletion.

Watchdog alarm that activates an SMS alarm
if no remote data is received after 1 day.
Checks for duplicate files found within a
7-day period. Will also trigger a SPAM
warning in the event log.
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Event tab
Refresh
log
Delete log

Export log to a .txt
Check box to limit log to display only
error messages.

Global tab
Unchecking this box will limit some
informational messages in the event
log (see Event tab).

Event log contains 1 day of events and errors,
then deletes those older than a day.

The Global File is not
used, all files are logged
to the database.

Will limit the number
of files parser per
scan interval if this
box is checked.
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